Table of Contents

Getting Started .................................................. 3

Finding Your Website in the Content Explorer ........................................ 3
Logging In ................................................................ 3
Changing Communities ........................................................................ 4
Logging Out ......................................................................... 4

Quick References ...................................................................... 5

Learning the Terminology ................................................................ 5
What is the Content Explorer? .......................................................... 5
What Information is in the Display Pane? ............................................. 6
What is an Action Menu? ................................................................ 9
What is the TinyMCE Editor? ............................................................ 10

Editing Existing Content ...................................................... 11

Modifying Text and Links ................................................................ 11
Adding Text (to an existing page, sidebar, or slider) ............................. 11
Editing Text (in an existing page, sidebar, or slider) .............................. 11
Removing a Link from a CMS Page .................................................. 12
Updating or Adding a Link on a CMS Page ........................................ 13
Updating a PDF ........................................................................ 14
Updating a Photo ........................................................................ 14
Updating an Image Banner ............................................................. 15
Updating a Link List ...................................................................... 16
Removing (Deleting) Content and Links .............................................. 17
Working with Tables ..................................................................... 17

Creating New Content ........................................................... 18

Creating New Text ...................................................................... 18
Creating New Generic (Pages) .......................................................... 18
Creating New Sidebars or Sliders ....................................................... 19
Creating an External Link ............................................................... 20
Adding New Faculty/Staff to a Directory ............................................ 21
Creating Grouped Items .................................................................. 22
Uploading a New PDF (or Other Document) ....................................... 22
Uploading a New Photo .................................................................. 23
Embedding a Video ....................................................................... 25
Creating a Slider ......................................................................... 25

Working with Links .................................................................... 26

Creating New Links ..................................................................... 26
Generics and Highlights: Linking to Content Within the CMS .............. 26
Generics and Highlights: Linking to Content Outside the CMS .......... 27
Updating Left-Side Navigation Links ................................................ 27
Modifying Existing Left-Side Navigation .......................................... 29

Managing Folders—Web Admin ................................................... 30

Creating a Folder ...................................................................... 30
Moving a Folder ......................................................................... 32

Best Practices: Search Engine Optimization and Usability .................. 34

FAQs ...................................................................................... 36

Glossary of Terms ................................................................. 39

CMS Blog: https://blogs.mtu.edu/webmaster  Email the web team: cmshelp@mtu.edu
CHAPTER 1

Getting Started

Finding Your Website in the Content Explorer

Prior to your first login, your web administrator will coordinate the proper permissions with the CMS staff. We recommend Safari or Internet Explorer as your browser choice. Firefox is also a supported browser, but will need Java enabled. You will also need to turn off your popup blocker for the CMS to work.

Logging In

1. Open a Web browser. We recommend Safari or Internet Explorer as your browser choice. (Firefox is also supported)
2. Browse to the following URL: http://cms.mtu.edu/Rhythmyx to access the CMS:

3. When prompted, type your Michigan Tech username and ISO password. Then click Login.

First Login Instructions

1. You may be prompted for the installation of a Security Certificate:
   “The application’s digital signature has been verified. Do you want to run the application?”
   Name: com.percussion.cx.PSContentExplorerApplet
   Publisher: PERCUSSION SOFTWARE
   From: http://noc-ryxdev1:9992
   Select the checkbox Always trust content from this publisher and then click Run.
2. You may be prompted for the installation of the Sun JRE browser plugin. If so, install it.
Changing Communities

1. Click the existing community to display the menu that reveals your options.

2. Select your community from the drop-down and click Go.

   NOTE: Remember that the “Member” Community is used for editing and creating content while the “Admin” Community is used to create folders, delete folders, and manage left-hand navigation.

Logging Out

1. Click the Logout button in the upper right-hand corner of the Content Explorer to end your session.

2. If you would like to log back in, click the provided link and type your username and password when prompted.
CHAPTER 2

Quick References

Learning the Terminology

There are just a few terms you need to know. For example, what is CMS? The short answer is that it’s a software system that allows you to create and store content for a website and manage it in a systematic way.

To learn more, go to the Glossary of Terms on p. 37 or watch our Common CMS Terminology training video: https://blogs.mtu.edu/webmaster/2011/01/common-cms-terminology/

What is the Content Explorer?

The Content Explorer is a web browser interface for Percussion’s Content Management System. As you become familiar with its features, you’ll be able to create and edit content, preview content, and create and remove folders. The Content Explorer looks like this:

Display Pane
(Right-click to edit content.)

Navigation Pane
(Right-click to create content.)
Community
A Community is a grouping that gives you access to specific information in CMS.

NOTE: Remember that the “Member” Community is used for editing and creating content while the “Admin” Community is used to create folders, delete folders, and manage left-hand navigation.

What Information is in the Display Pane?

Content Title
In the Content Title column, you will see a list of items. Each item of content (or each row in the Display Pane) is called a Content Item in the CMS. In the Content Explorer example on the previous page, there are two Content Items. The Content Title is often referred to as the System Title.

When you log in to your community, the Content Items will be limited to the Content Types associated with your community. A Content Item can be reformatted for multiple uses.

Each Content Item has a checkout status (see key below). In the display pane shown on the previous page, the first Content Item is checked out, signified by a locked lock in the Checkout Status column, and cannot be edited. The second Content Item is unlocked, checked in, and available for editing. These symbols and their meanings are further explained in the next section.

Checkout Status
In the Checkout Status column, you will see a locked, unlocked, or editing icon. Checking in your file when you’re finished will unlock it and make it available to others. You will become familiar with these symbols as you work within the CMS.

Checkout Status Key

- Locked. Someone else has the file checked out.
- Unlocked. The file is checked in and available.
- Editing pencil. You (the user) currently have this file checked out and are editing it.
State
In the State column, four different labels could be visible. They indicate the state of the document as it transitions through an established Workflow. The role you’re assigned determines how you can transition the file.

**Draft**—Content has just been created or has returned to this state for modifications.

**Public**—Content is ready to be published to your live website.

**Quick Edit**—Content is taken out of the Public state for modifications. The previous version remains on your website. When finalized, item must be returned to the Public state to be published.

**Archive**—Content is taken out of the Public state for archiving. Content can also have a preset date (Expiration Date) that automatically ages it to the Archive state. Archived content can be returned to the Public or Draft states later on as necessary.
Content Type

A Content Type is like a category. Each category is programmed with information that gives the content on your web page its characteristics. For example, one Content Type might store uploaded images while another could store promotional text or even a file.

Each Content Type is identified with a label, such as (bold names indicate the most used files):

- **Generic (Page)** (the actual web page)
- **Highlight** (most often used as sidebars or sliders)
- **File** (holds PDFs, Word documents, spreadsheets, and other files)
- **Image Editor** (used for images and their cropped versions)
- **Banner** (custom image sizes)
- **Personnel Information** (used for the faculty and staff directory)
- **External Link** (used for non-CMS links)
- **Grouped Item** (most often used to compile staff units for the directory)

<table>
<thead>
<tr>
<th>A Content Title</th>
<th>Checkout status</th>
<th>State</th>
<th>Content Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Humanities Grad Program At a Glance Highlight</td>
<td>Public</td>
<td>Highlight</td>
<td></td>
</tr>
<tr>
<td>Humanities Grad Program Degrees Slider</td>
<td>Public</td>
<td>Highlight</td>
<td></td>
</tr>
<tr>
<td>Humanities Graduate Contact Right Sidebar</td>
<td>Public</td>
<td>Highlight</td>
<td></td>
</tr>
<tr>
<td>Humanities Graduate Program</td>
<td>Public</td>
<td>Non</td>
<td></td>
</tr>
<tr>
<td>Humanities Graduate Program From the Distance</td>
<td>Public</td>
<td>Non</td>
<td></td>
</tr>
<tr>
<td>Humanities Graduate Program Landing Page</td>
<td>Public</td>
<td>Non</td>
<td></td>
</tr>
<tr>
<td>Humanities Graduate Program Message from the Distance</td>
<td>Public</td>
<td>Non</td>
<td></td>
</tr>
<tr>
<td>Humanities Graduate Program NewsBlog Ex...</td>
<td>Public</td>
<td>Non</td>
<td></td>
</tr>
<tr>
<td>Shared Humanities Ask A Question Button</td>
<td>Public</td>
<td>Non</td>
<td></td>
</tr>
</tbody>
</table>

The most common CMS items are as follows:

**Generic (Page):** The Generic (Page) is an actual web page on your website. It may contain all of the content that you see on that particular web page on your website. It may also simply be used as a container or holder, which pieces together multiple pieces of content (such as Highlights and Grouped Items) that actually make up and contain the content that you see.

**Highlight:** A Highlight is a small piece of web content that appears on a web page. We use Highlights when we want to take a small piece of text and format it in a special way. These formats are often Right Sidebars and Sliders. Highlights are slotted (attached) to Generic (Pages).

**File:** A File is a CMS item that you use to upload any time of file that you want. This could be a Word Doc, Excel Spreadsheet, PDF, XML document, PowerPoint Presentation, or so much more. To add a file to your website, first create a File in the CMS. Once your file is loaded into the CMS, you can link to it.

**Image Editor:** The image editor is used for images and most images found in the CMS are done using the image editor. The image editor allows you to add an image to the CMS based off nine predefined templates (based on size and aspect ratio). The most common templates are: medium thumbnail, horizontal image, personnel image, and right sidebar. Each size has a specific purpose.
What is an Action Menu?

It is a list of functions that allow you to take action. Right-click on folders in the Navigation Pane or items in the Display Pane to display the Action Menu.

**Folders Key**
- ![Site Folder](image)
- ![Content Folder](image)
- ![Click to collapse folder](image)
- ![Click to expand folder](image)

**Action Menu**
(Right-click menu)
What is the TinyMCE Editor?

The Editor is an authoring tool that makes it easy for you to format your text.

NOTE:

Each chapter ends with reference links to the CMS blog that provide additional information and examples. Our CMS blog is the most up-to-date repository for CMS instructions and information and should be your first stop for common CMS questions.


Still need help? Reference our most up-to-date instructions online:
Modifying Text and Links

In this section, you’ll add or edit text on an existing page. You will also learn about modifying existing links. The text you’ll most often modify is on Generic or Highlight items. (See these listed under Content Type in the Content Explorer.)

Adding Text (to an existing page, sidebar, or slider)

1. Open the CMS. Make sure you are logged into the proper Community and then locate the item that you wish to update. If you can’t find your item, perform a CMS Search: http://blogs.mtu.edu/webmaster/2010/03/cms-search-specific-folders/
2. Right-click the Generic or Highlight item that you want to modify and select QuickEdit or Edit.
3. Scroll down to the Body or Callout area, where you want to add new text.
4. Click the Design tab to load the TinyMCE Editor for formatting options.
5. Click on the full-screen icon so you can see all the text.
6. Add new text, then close the full-screen window.
7. Click Update to save your changes, then click Close.
8. Right-click the Generic (Page) or Highlight and select the top option under the Preview menu to Preview your changes.
9. Make additional changes and/or return the item to Public as necessary.

Still need help? Reference our most up-to-date instructions online:

Styling & Coding Clean Up— http://blogs.mtu.edu/webmaster/2013/01/clean-up/

Editing Text (in an existing page, sidebar, or slider)

1. Open the CMS. Make sure you are logged into the proper Community and then locate the item that you wish to update. If you can’t find your item, perform a CMS Search: http://blogs.mtu.edu/webmaster/2010/03/cms-search-specific-folders/
2. Right-click the Generic or Highlight item that you want to modify and select QuickEdit or Edit.
3. Scroll down to the Body or Callout where you want to edit the text.
4. Click the Design tab to load the TinyMCE Editor for formatting options.
5. Click on the full-screen icon so you can see all the text.
6. Edit the text, then close the full-screen window.
7. Click Update to save your changes, then click Close.
8. Right-click the Generic (Page) or Highlight and select the top option under the Preview menu to Preview.
9. Make additional changes and/or return the item to Public as necessary.

Still need help? Reference our most up-to-date instructions online:
Styling & Coding Clean Up— http://blogs.mtu.edu/webmaster/2013/01/clean-up/

Removing a Link from a CMS Page

1. Open the CMS. Make sure you are logged into the proper Community and then locate the item that you wish to update. If you can't find your item, perform a CMS Search: http://blogs.mtu.edu/webmaster/2010/03/cms-search-specific-folders/
2. Right-click the Generic or Highlight item containing the link you need to remove and select QuickEdit or Edit.
3. Scroll down to the Body or Callout where you want to edit the text.
4. Click the Design tab to load the TinyMCE Editor for formatting options.
5. Click in the link so that your cursor is blinking within the link and then click the Remove Hyperlink button 📝.
6. The hyperlink has now been removed.
7. Click Update to save your changes, then click Close.
8. Right-click the Generic (Page) or Highlight and select the top option under the Preview menu to Preview.
9. Make additional changes and/or return the item to Public as necessary.

Still need help? Reference our most up-to-date instructions online:
Adding/Modifying Links on Pages/Sidebars—http://blogs.mtu.edu/webmaster/2010/02/linking/
Updating or Adding a Link on a CMS Page

1. Open the CMS. Make sure you are logged into the proper Community and then locate the item that you wish to update. If you can't find your item, perform a CMS Search: http://blogs.mtu.edu/webmaster/2010/03/cms-search-specific-folders/

2. Right-click the Generic or Highlight item containing the link you need to update and select QuickEdit.

3. Click inside the Body or Callout area to load the TinyMCE Editor.

4. Click in the link so that your cursor is blinking within the link and then click the Remove Hyperlink button.

5. Your old link is now removed and the text is highlighted. Keep it highlighted.

6. Decide if you need an *internal* or *external* link

   a. Click Insert Hyperlink if you are updating an external link. Type the new external URL in the address field.

   b. Click Insert Rhythmyx Inline Link button if you’re linking to a page or PDF that is located in the CMS repository. Use the search features to find the new page or PDF.

7. Click Update and then Close.

8. Right-click the Generic (Page) or Highlight and select the top option under the Preview menu to Preview.

9. Make additional changes and/or return the item to Public as necessary.

Still need help? Reference our most up-to-date instructions online:

Adding/Modifying Links on Pages/Sidebars—http://blogs.mtu.edu/webmaster/2010/02/linking/

Learn More

- Uploading a new PDF—Adding a PDF link to your page. Go to p. 22.
- Modifying a Link List—Adding or removing links. Go to p. 16.
Updating a PDF


2. Open the CMS. Make sure you are logged into the proper Community and then locate the item that you wish to update. If you can’t find your item, perform a CMS Search: [http://blogs.mtu.edu/webmaster/2010/03/cms-search-specific-folders/](http://blogs.mtu.edu/webmaster/2010/03/cms-search-specific-folders/).

3. Right-click the File and select QuickEdit or Edit.

4. Click Browse and locate your new PDF (it'll be on your computer in the location that you chose to save it in. Select it from the menu and click Open to upload it.

5. Click Update, then Close.

6. Right-click the File and select the top option under the Preview menu to Preview.

7. Make additional changes and/or return the item to Public as necessary.

Still need help? Reference our most up-to-date instructions online:


Learn More


Updating a Photo

1. If you are replacing an existing photo with a new one, first save the new photo to your computer (Home Drive, Desktop, or other location). If you are only recropping or adding new crop sizes, skip to the next step.

2. Open the CMS. Make sure you’re logged into the proper Community. Locate the image you wish to update. It will most likely be an Image Editor item, but may be a Banner. You may need to perform a CMS Search: [http://blogs.mtu.edu/webmaster/2010/03/cms-search-specific-folders/](http://blogs.mtu.edu/webmaster/2010/03/cms-search-specific-folders/)

3. These instructions will guide you through the process of overwriting your old image with a new image, which is the easiest way to update the photo on your website. If you instead want to keep the old image in the CMS and add a new image separately, please turn to the section entitled “Uploading a New Photo.”
4 If the image is a Banner item, skip to the next page. Otherwise, continue.
5 Right-click the Image Editor file that holds your image and select Edit Image.
6 Edit the appropriate information in the dialog box fields (System Title, Display Title, Image Alt Text, and Image Description as needed).
7 Click Browse and locate your new image. Select your image and click Open to upload it. Only do this if you need to load a brand new image. Skip to the next step if you are only recropping or adding new crop sizes to the existing image.
8 Select the sizes of the images you’d like to have available (if not already selected). For more information about the different sizes, refer to our online guide: http://blogs.mtu.edu/webmaster/2011/02/image-editor/
9 Click Next and crop the image by clicking and dragging on the small red squares that represent the new borders of the photo.
10 When finished, repeat until a confirmation screen appears showing a preview. Use the buttons to go back and make additional changes if needed.
11 Click Save and Exit.
12 Return your image to Public if necessary.

Still need help? Reference our most up-to-date instructions online:
Using the Image Editor—http://blogs.mtu.edu/webmaster/2011/02/image-editor/
Aligning Items (Images)—http://blogs.mtu.edu/webmaster/2011/02/alignment-of-items/

Having Image Editor Errors?
Common Image Editor Errors—http://blogs.mtu.edu/webmaster/2011/02/image-editor/#errors

---

**Updating an Image Banner**

Your department’s website is most likely filled with photo banners to liven up its look and feel. Photo banners appear at the top of web pages and include a border around them. We generally make sure each level 1 webpage (main left navigation links) has a full banner. Level 2 web pages (sub-navigation to main left navigation links) may use banners or sub-banners depending on content and preferences. The use of banners and sub-banners varies by department and website section.

1 Create your new banner using the photo editing software that is available to you. The following dimensions are recommended:
   a. For a full banner, use 715px wide by 160px tall (the height can be variable).
   b. For a sub-banner, use 465px wide by 160px tall (the height can be variable).
2 Save it to your computer (Home Drive, Desktop, or other location).
3 Open the CMS. Make sure you’re logged into the proper Community. Locate the old Banner Image. You may need to perform a CMS Search: http://blogs.mtu.edu/webmaster/2010/03/cms-search-specific-folders/
4 If it is an Image Editor file, please refer to the section on the previous page entitled “Updating a Photo”. Select the size “Full Size Horizontal” for a full banner and the size “Horizontal” for a sub-banner.

5 If it is a Banner file, please refer to our most up-to-date instructions online: http://blogs.mtu.edu/webmaster/2009/11/updating-banners/

Still need help? Reference our most up-to-date instructions online:
Using the Image Editor—http://blogs.mtu.edu/webmaster/2011/02/image-editor/

Learn More


Updating a Link List

1 Open the CMS. Make sure you’re logged into the proper Community. Locate the Link List that you wish to update. You may need to perform a CMS Search: http://blogs.mtu.edu/webmaster/2010/03/cms-search-specific-folders/

2 Right-click the Link List to edit it.

3 The Title field controls the text at the top of the link list (the non-linked title of the link list). Edit as needed.

4 Click Update.

5 Click Edit All.

6 To add a new link, click on the text Links(645).

7 Browse to the already existent CMS item that you wish to add to the Link List. Generic (Page), File, and External Link are common choices. To create a new Generic (Page), refer to page 18. To create a new File, refer to page 22. To create a new External Link, refer to page 20.

8 Click on your item, select the top template, and the click Open.

9 Close any open windows.

10 Return item to Public if necessary.

11 Preview the Generic (Page) that the Link List is on by right-clicking the Generic (Page) and selecting the top option from the Preview menu.
Still need help? Reference our most up-to-date instructions online:


To create a new External Link, refer to page 20.

Learn More


Removing (Deleting) Content and Links

The time may come to remove or delete content or links from your website. This can be done quickly and easily once you understand what scenario you are facing. You can read our most up-to-date step-by-step instructions on our blog post at:

Deleting or Removing Content and/or Links—http://blogs.mtu.edu/webmaster/2014/02/deleting-removing/

Working with Tables

Although using tables to organize content is a thing of the past, tables are still useful for displaying and organizing data. Once you have your basic HTML code set up, you can use these tips for sorting, styling, or aligning your tables or table elements:

Sortable Tables—http://blogs.mtu.edu/webmaster/2013/04 sortable-tables/
Styling Tables—http://blogs.mtu.edu/webmaster/2013/04 sortable-tables/
Aligning Items—http://blogs.mtu.edu/webmaster/2011/02 alignment-of-items/
Creating New Content

Chapter 4

Creating New Content

Creating New Text

The first steps to creating anything new is to:

1. Identify where it will go.
2. Determine how you want to display the new content (body copy, sidebar, directory).

Your department website has been set up with a folder structure to organize content. When you create a new content item in the appropriate folder, you will set its Content Type (e.g., generic, highlight, file). This pre-set assignment will determine the characteristics of your new text.

Creating New Generic (Pages)

1. Choose a desired folder for your new CMS web page. You may need to create a new folder. If needed, refer to p. 30. You may also choose a folder that already contains a web page where you want to add another page.
2. Right-click the chosen folder (in the navigation pane) and select New Item > Generic (Page).
3. Fill in the fields in the content form. Refer to already-created items in the CMS for guidance if needed.
4. At the bottom, click Insert, then Close.
5. Right-click the item and select the top option under the Preview menu to Preview.
6. Make additional edits if necessary.
7. Transition the item to Public if necessary.
8. If you are creating a new web page that needs to show up in the left-hand navigation, refer to p. 27 for additional instructions.

Learn More

Creating New Sidebars or Sliders

1. Choose a desired folder for your new sidebar. It is generally a good idea to choose the folder that contains the Generic (Page) that you will be placing the sidebar on.

2. Right-click the chosen folder (in the navigation pane) and select New Item > Highlight.

3. Fill in the fields of the Highlight form. The Title controls the Title of the sidebar. The callout field controls the content within the sidebar.

4. Click Insert, then Close.

5. Transition the Highlight to Public, if necessary.

6. Right-click the Highlight and select the top option under the Preview menu to Preview. The preview will only be useful to see if any links work. The styling won’t look accurate until the sidebar is added to Generic (Page).

Now you’re ready to add the Highlight to any page as a sidebar by sloting it on the page.

Slotting a Highlight in a Sidebar

1. Right-click the Generic (Page) where the sidebar will appear and select QuickEdit.

2. Scroll to the bottom and click Edit All.

3. Click on either “Slot(ID): Right Sidebar Slot – Boxed (565)” or “Slot(ID): Right Sidebar Slot – No box (539)” to select the style template of the right sidebar box. Typically, you’ll want the Boxed slot. The different slots control the look of the sidebar.

4. Use the search box to locate the Highlight you already created. Click on the name of the Highlight to select it.

5. Click on the Title with Callout, Boxed template and then click Open.

6. Click Close. Return your item to Public if necessary.

7. Right-click the Generic (Page) and select the top option under the Preview menu to Preview.

Slotting a Slider in a Sidebar

1. Right-click the Generic (Page) where the slider will appear and select QuickEdit or Edit.

2. Scroll to the bottom and click Edit All.

3. Click on the “Slot(ID): List slot (509)” to launch the Content Browser to locate the Highlight that will be used as a slider.

4. Select the Highlight and select “Slider” from the template choices that are presented on the left side of the Content Browser window.

5. Select Open and click Close on the Slot Editor.

6. Return your item to Public if necessary.

7. Right-click the Generic (Page) and select the top option under the Preview menu to Preview.
Still need help? Reference our most up-to-date instructions online:

Adding/Modifying Links on Pages/Sidebars—http://blogs.mtu.edu/webmaster/2010/02/linking/
Adding Items to the Right Sidebar (Slotting)—http://blogs.mtu.edu/webmaster/2009/11/adding-right-sidebar/

Creating an External Link

1. Choose a folder in the CMS to put your External Link item in. It will often be the folder that contains the Navon or Link List that the External Link will be used with.
2. Right-click the appropriate folder and select New Item > External Link.
3. Fill in the fields of the external link form. The title will control the Link Text itself. The URL will control the URL of the link.
4. Click Insert and then Close.
5. Transition your item to Public if necessary.

Slotting an External Link

External links are often used in conjunction with link lists. See the Updating Link Lists section on p. 16 for a walk-through exercise. External links are also often used with left-hand navigation. Refer to p. 27 for a walk-through exercise.

1. QuickEdit the Link List in the directory of the page where the External Link will appear.
2. Scroll to the bottom and click Edit All.
3. Click on “Slot(ID): Links (645).”
4. Use the visual search or advanced search box to locate your External Link.
5. Click the external link and then click the template that appears.
6. Click Open.
7. Repeat steps 3-5 until you have slotted all your links.
8. Click Close.
9. Return your Link List to Public if needed.
10. Right click the Generic (Page) and select the top option under the Preview menu to Preview.
Adding New Faculty/Staff to a Directory

Information for new staff and faculty is assembled using the techniques you’ve learned in previous exercises. The content you create will be grouped to display the final web page.

1. If this is a faculty member, you may have to create a folder first. The folder is likely going to be the faculty member’s last name. You will need to be in the Admin community to create a folder. If a folder is not needed, you may skip this step.

2. Crop an image of the new staff member using the Image Editor. Select “Personnel” for the image size. (Image Editor instructions are on pages 23 and 24).

3. Right-click the CMS folder where your faculty/staff are stored (commonly a staff or faculty folder) and select New Item > Personnel Information.

4. Fill in the fields of the Personnel Information form up to and including the Quote Source. You only have to fill in the fields that you want to. Note: “Address 1” should be filled out with the person’s building and room number. Following this format: Administration Building G13.

5. Click Insert.

6. Once the form reloads you have the option of using up to three lists. Two on the left and one on the right. You can call these lists whatever you want. Click Return to parent in the top left corner to access the next list.
   a. Left List 1 Title: Links of Interest (pre-populated, but can be changed). Click the Edit table button below the Title to add items.
   b. Left List 2 Title: [Fill in the Field]. Click the Edit table button below the Title to add items.
   c. Right List 1: Specialties (pre-populated, but can be changed). Click on the Edit table button below the title Specialty to add items.

7. Additional fields can be filled out for biographical information, extra information you want in a list format, and degree information. This is content most often found on faculty pages and expert modules, but not necessary for staff directories.

8. Click on Edit All. Slot the new staff member’s photo into Home Image (501).

9. Click Update and then, at the bottom of the form, Close.

10. Transition the item to Public if necessary.

11. If you’re folder contains a Grouped Item, we will most likely need to add the new Personnel Item to the Grouped Item. Quick Edit the Grouped Item.

12. Click Edit All.

13. Slot the Personnel Item into the Group List (595) slot.

14. If necessary, a Curriculum Vitae can be added to the Curriculum Vitae (785) slot.

15. Click Close.

16. Return the Grouped Item to Public.
Creating New Content

Still need help? Reference our most up-to-date instructions online:
Staff Directory (Personnel Items)—http://blogs.mtu.edu/webmaster/2009/10/personnel-items/
Image Editor—http://blogs.mtu.edu/webmaster/2011/02/image-editor/

Creating Grouped Items

If a Grouped Item for your department or unit already exists (commonly in staff folder), slot your new Personnel Information item in Group List (595). Grouped Items are used when listings are not alphabetized.

If you are creating a new Grouped Item, follow these steps:

1. Right-click the appropriate folder (commonly staff or faculty folder) where you want to create a new Grouped Item and select New Item > Grouped Items.
2. Fill in the fields of the Grouped Items form. The title should be a description of the Group, such as “Faculty Listing”. Choose the appropriate dropdown menu selection such as “Staff” for a faculty or staff listing.
3. Click Insert.
4. Click Edit All and slot the new Personnel Information item (or other items) in Group List (595) Slot.
5. Click Update and then Close.
6. Transition the item to Public if necessary.

Still need help? Reference our most up-to-date instructions online:
Staff Directory (Personnel Items)—http://blogs.mtu.edu/webmaster/2009/10/personnel-items/

Uploading a New PDF (or Other Document)

If your PDF is not on your department’s website yet, or has not been uploaded to the CMS, you’ll need to take the following steps.

1. Save the PDF to your computer (Home Drive, Desktop, or other location). Make sure that your file is named in a way that is “safe for the web”: http://blogs.mtu.edu/webmaster/2009/09/good-file-naming-conventions/
2. Choose a folder in the CMS to store your PDF in. It could be an existing folder called “PDFs” or “docs”. You can also create a new folder by referring to p. 30.
3. Right-click the appropriate folder and select New Item > File.
4. Fill in the fields of the File form.
   a. In the System Title and Title fields, type a name similar to the PDF so you’ll be able to recognize it when you search for it.
   b. The Start Date will already be filled in.
c. The Expiration Date or Reminder Date are optional. Usually they are left blank.
d. For File, click Browse, locate the PDF you’d like to upload, click it, then click Open.
5 Click Insert. The dialog box will flash and update. Then, click Close.
6 To link to your PDF, see Linking to Content Within the CMS on p. 13.

Still need help? Reference our most up-to-date instructions online:

Learn More

Uploading a New Photo

If you would like to upload a new photo to your department’s website, take the following steps.

1 Save the photo to your computer (Home Drive, Desktop, or other location).
2 Choose a folder in the CMS to store your photo in. It could be an existing folder called "images". You can also create a new folder by referring to p. 30.
3 Right-click the appropriate folder of your choice (commonly image folder) and select New Image.
4 Fill in the fields of the Image Editor form.
   a. In the System Title field, type a name for the photo. This title will appear in CMS.
   b. In the Display Title field, type the same name you input for the System Title.
   c. In the Image Alt Text field, type a description of the photo in 3-5 words.
   d. (Optional) Image Description field, type a full description of the photo. Keep in mind that this may also be used as a photo caption later.
   e. Click Browse to select the photo you’d like to upload. In the File Upload window, find the photo, click it, and then click Open.
5 Select the sizes of the photo you’d like to have, even if you’re not going to use them right now. It makes a larger selection available to other CMS users.
<table>
<thead>
<tr>
<th>Image Type Name</th>
<th>Dimensions</th>
<th>Suggested Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>170 Square</td>
<td>170 x 170</td>
<td>•In content, supplements short paragraphs, to add visuals&lt;br&gt;•Can be used in the Personnel Image slot&lt;br&gt;within Profile items (be sure to crop the 250 square also) or within content</td>
</tr>
<tr>
<td>250 Square</td>
<td>250 x 250</td>
<td>•Supplements longer paragraphs, to add visuals&lt;br&gt;•Can be used in the Personnel Image slot&lt;br&gt;within Profile items (be sure to crop the 170 square also) or within content</td>
</tr>
<tr>
<td>Personnel Image</td>
<td>170 x 230</td>
<td>•Faculty and staff listing photos&lt;br&gt;•Can be used in the Personnel Image slot</td>
</tr>
<tr>
<td>350 Sidebar</td>
<td>350 x Variable (175px height recommended)</td>
<td>•Images that fit in the right sidebar&lt;br&gt;•Can be used in a highlight in the Right Sidebar Slot - Boxed or Right Sidebar Slot - No box or within content in a 3- or 4- column layout</td>
</tr>
<tr>
<td>515 Sub-Banner</td>
<td>515 x Variable (250px height recommended)</td>
<td>•Images that fit between the left navigation and right sidebar&lt;br&gt;•Image Callouts&lt;br&gt;•Can be used in the Sub-Banner slot or within content in a 2-column layout</td>
</tr>
<tr>
<td>765 Banner</td>
<td>765 x Variable (300px height recommended)</td>
<td>•Images at the top of a page that are next to the left navigation or right sidebar&lt;br&gt;•Can be used in the Banner Image slot</td>
</tr>
<tr>
<td>1024 Feature</td>
<td>1024 x Variable (375px height recommended)</td>
<td>•Homepage mediazone images, banner images that take the full content width&lt;br&gt;•Can be used in the Featured Images slot or a Mediazone item</td>
</tr>
<tr>
<td>1600 Feature</td>
<td>1600 x Variable (520px height recommended)</td>
<td>•Homepage mediazone images&lt;br&gt;•Can be used in the Featured Images slot or a Mediazone item</td>
</tr>
</tbody>
</table>

6. Click Next and crop the image by clicking and dragging on the small red squares that represent the new borders of the photo.

7. When finished, repeat step #4 until a confirmation screen appears showing a preview of all the images you cropped.

8. Click Save and Exit.

Still need help? Reference our most up-to-date instructions online:

Using the Image Editor—http://blogs.mtu.edu/webmaster/2011/02/image-editor/

Aligning Items (Images)—http://blogs.mtu.edu/webmaster/2011/02/alignment-of-items/


Having Image Editor Errors?

Image Editor Errors—http://blogs.mtu.edu/webmaster/2011/02/image-editor/#errors
Embedding a Video

If you would like to embed a video on your department’s website, reference our most up-to-date blog post for instructions at:

Embedding a Video—http://blogs.mtu.edu/webmaster/2013/10/embedding-a-video/

Creating a Slider

If you would like to create a new slider for your department’s website, reference our most up-to-date blog post for instructions at:

Creating and Adding Sliders—http://blogs.mtu.edu/webmaster/2014/03/creating-and-adding-sliders/
Chapter 5

Working with Links

Creating New Links

This section is about linking from a CMS page. You will learn about creating hyperlinks from text and left-side navigation. You can learn about creating External Link Content Types on page 17.

Generics and Highlights: Linking to Content Within the CMS

You can link to CMS pages or files, e.g., PDFs, on your site or on other department sites within CMS. Linking to CMS content in communities outside of your own is done in the same manner as linking to information in your own community.

1 If you are removing/modifying a link, please refer to page 12. If you are creating a new link, continue with these instructions.

2 In the CMS, Edit the Generic or Highlight page where you would like to create a link.

3 Click inside the Body or Callout area to open the TinyMCE Editor.

4 Type in new text that you will then link or highlight the existing text that you want to link.

5 Click on the Insert Rhythmyx inline link button and locate the file or page in the CMS which we want to link to. (Refer to page 10 for the button diagram)

6 Click Update and then Close.

13 Right-click the Generic (Page) or Highlight and select the top option under the Preview menu to Preview.

14 Make additional changes and/or return the item to Public as necessary.

Still need help? Reference our most up-to-date instructions online:

Adding/Modifying Links on Pages/Sidebars—http://blogs.mtu.edu/webmaster/2010/02/linking/
Generics and Highlights: Linking to Content Outside the CMS

You can link to web pages of other Michigan Tech websites that are not in CMS, as well as to pages from any other website on the Internet.

1. If you are removing/modifying a link, please refer to page 12. If you are creating a new link, continue with these instructions.

2. In the CMS, Edit the Generic or Highlight page where you would like to create a link.

3. Click inside the Body or Callout area to open the TinyMCE Editor.

4. Type in new text that you will then link or highlight the existing text that you want to link.

5. Click on the Insert Hyperlink… button. (Refer to page 10 for the button diagram)

6. Enter the destination web address (URL) in the Address field and click OK.

7. Click Update and then Close.

8. Right-click the Generic (Page) or Highlight and select the top option under the Preview menu to Preview.

9. Make additional changes and/or return the item to Public as necessary.

Still need help? Reference our most up-to-date instructions online:
Adding/Modifying Links on Pages/Sidebars—http://blogs.mtu.edu/webmaster/2010/02/linking/

Updating Left-Side Navigation Links

For those with web admin privileges, in this section you will learn to create and update links for left-side navigation. You must be logged into the admin community to be able to complete the steps below.

The left-side navigation menu is composed of links. There are two main content types that can be used in the left-side navigation: a generic web page and an external link. Outlined below is the process for linking each content type.

Linking a Generic Landing Page to the Left-Side Navigation

1. Verify that you are logged in as an Admin by looking to the top right side of the Content Explorer and noting the Community section.

2. If you are adding a new link to the navigation, create a new folder to house your new web page. If you are modifying an existing navigation link, find the folder with the web page you would like to target in the navigation.

3. Open the Navon content type contained in that folder. The Navon must not be in the Public State in order to edit it. If it is in the Public state, transition it to Quick Edit by right clicking on it and selecting Workflow > Move to Quick Edit. Then double-click or right-click and select Edit.
Click the Edit All button at the bottom to open the Active Assembly Table Editor.

Find the Nav Landing Page (510) slot and click on the Nav Landing Page title. This will open the CMS Search Query window.

Use the Content Browser to locate the item you would like to use as the landing page.

Select the page you want to slot on the Navon.

Click Update and then Close.

Return all items to Public as necessary.

Verify that your navigation has been updated by logging in to your community as a member and previewing the landing page.

Please contact the UMC web team at cmshelp@mtu.edu to request a special full publish of your website. Your navigation will not fully update until we run a full publish of your website.

---

**Linking an External Link Content Type to the Left-Side Navigation**

If you wish to link to a page not currently in the CMS, you can link to that page by using an External Link. (Also see Creating an External Link as a Content Type on p. 20.)

1. In the Admin community, right-click and create a new folder.
2. After you have created the folder, double-click or right-click on the Navon within the folder to open it.
3. Change the System Title to the new name.
4. Change the Title to the name that will appear in the navigation.
5. Click Update and then Close.
6. Logout and log back in to your Member community.
7. Right-click on the folder you just created and click New Item > External Link.
8. Enter the System Title.
9. Enter the Title.
10. Enter the URL of the page you want to link.
11. Select Insert and then Close.
12. Log out of the Member community and back to the Admin community.
13 Double-click on the Navon that was created earlier to open.
14 Click the Edit All to open the Table Editor.
15 Find the Nav Landing Page (510) slot and click on the Nav Landing Page title. This will open the Search Query window.
16 Use the Content Browser to locate and select the External Link you want to slot on the Navon.
17 Click Update and then Close.
18 Verify that your navigation has been updated by logging in to your Member community and previewing the landing page.
19 Please contact the UMC web team at cmshelp@mtu.edu to request a special full publish of your website. Your navigation will not fully update until we run a full publish of your website.

Modifying Existing Left-Side Navigation

1 Make sure you’re logged in to the Admin community.
2 Quick Edit the Navon in the folder you are working in.
3 Click the Edit All button at the bottom to open the Active Assembly Table Editor.
4 Find the Nav Landing Page (510) slot.
5 Use the Action buttons to remove your web page from the left hand navigation by clicking the red X (second button from the right).
6 Please contact the UMC web team at cmshelp@mtu.edu to request a special full publish of your website. Your navigation will not fully update until we run a full publish of your website.

Note: You may need to check in all items before your previews will work.

Learn More

Creating a Folder

If you would like to create a new folder within the CMS, you must take the following steps.

1. Change your Community.
   a. To create a folder in the CMS, you must be in your department’s Admin community.
   b. Click on the link next to Community: at the top of the screen.
   c. Select [DepartmentName]_Admin in the subsequent drop-down menu.
   d. Click on Go. You will automatically return to the CMS.

2. Locate where you’d like to create your folder.
   a. Use the pane on the left side of the window to locate the folder you’d like to create a new folder in.
3 Create your new folder.
   a. Right-click the folder and select New Folder.
   b. A window will open, allowing you to name the folder.
   c. Name your folder by entering in the Folder Name field.
   d. Use a logical and descriptive name for the folder, as it will also appear in URLs.
   e. Click OK.
4 Confirm that your folder was created.
   a. Your folder will now appear in the left-side pane.

5 Return to your Member Community.
   a. Click on [DepartmentName]_Admin located in the top of your window above the Logout button.
   b. Select [DepartmentName]_Member from the drop down menu.
   c. Click Go. You will automatically return to the CMS.

Learn More


Moving a Folder

If you would like to move a folder within the CMS, you must take the following steps.

1. Transition all items in the folder that you want to Move to QuickEdit. This includes all items in your Member Community and your Admin Community. You can accomplish this using a CMS search: http://blogs.mtu.edu/webmaster/2010/03/cms-search-specific-folders/ and transitioning all the results to QuickEdit.

2. Change your Community.
   a. To create a folder in the CMS, you must be in your department’s Admin community.
   b. Click on the link next to Community: at the top of the screen.
   c. Select [DepartmentName]_Admin in the subsequent drop down menu.
   d. Click on Go.
e. You will automatically return to the CMS.

3. Locate the folder you’d like to move.
   a. Use the pane on the left side of the window to locate the folder you’d like to move.
   b. Right-click the folder, and select Copy.

4. Locate the folder you’d like to move the folder to.
   a. Use the pane on the left side of the window to locate the folder you’d like to move to.
   b. We’ll call this Folder 2.

5. Move your folder.
   a. Right-click Folder 2, and select Paste -> Move.
   b. The folder now resides in Folder 2.

6. Return to your Community.
   a. Click on [DepartmentName]_Admin located in the top of your window above the Logout button.
   b. Select [DepartmentName] from the drop down menu.
   c. Click Go.
   d. You will automatically return to the CMS.
Best Practices: Search Engine Optimization and Usability


Do you have pages with a lot of text and wonder if that is OK? Are your pages user-friendly? Do you want to increase your search engine rankings? Here are some tips to make your website better for your users and increase your visibility in searches.

Content-Rich Page Examples

The “What is Biomedical Engineering” (http://www.mtu.edu/biomedical/department/what-is) page shows good use of headings in a page that has a lot of content. The sections don’t drag on because the headings break up the content. They also make the content more scannable for both users and search engines. Using the images to break up the large amount of text rather than placing them at the top or side of the page is another way to make the page more user-friendly.

Notice the keywords that are bolded and others that are linked to relevant pages. Highlighting the keywords in this way makes it look better to search engines and may increase your rankings. It also makes the most important topics pop out to the reader. Just be sure not to overdo it (a couple times per story should be enough). Google knows when you’re trying to cheat and there is a penalty for it!

The “What is Mechanical Engineering” (http://www.mtu.edu/mechanical/engineering) page also uses these principles. In addition, this page includes bullets to further break up the content and make it feel less overwhelming. Properly using headings and bullets makes your content easier to read.

Keywords

Keywords, and how you use them on your pages, play an important role in search engine optimization (SEO). But keep in mind there can be too much of a good thing. You can be ranked lower for “keyword stuffing.” Write naturally, then pick out the keywords to highlight.

- Use keywords in the URL. The URL is determined by the names of the folders.
  - Keep folder names to one to two keywords separated by a hyphen.
  - Always use lower case; never symbols or spaces.
  - These guidelines also apply to filenames (PDFs, Word Docs, etc).
- Use keywords in the page title.
- Use keywords in the headings.
- Link keyword phrases across your site and to other relevant sites on campus.
- Use keywords throughout the body copy and add style to them where appropriate (bold or italics). Avoid underlines—they can be mistaken for a link.
Search Engine Optimization (SEO)

Besides using keywords strategically there are several other things you can do to make your pages rank higher in searches. The University Marketing and Communications website provides more information and resources on these methods for improving your site’s ranking (http://www.mtu.edu/umc/services/web/seo).

- Publish relevant content.
- Update your content regularly.
- Include metadata, information about the content of your pages, via the keywords and description fields in the CMS.
- Have a link-worthy site.
- Use alt tags to describe your visual and video media.

Usability

Think about your users when writing the content (http://www.mtu.edu/umc/services/web/writing) and designing the layout for your pages. If it isn’t easy for them to navigate or is too overwhelming, they will not stay long enough to get the information you want them to have.

- Use headings, lists, and bullets.
- Don’t make the user click. They are happy to scroll.
  - Instead of 10 pages that each have one paragraph on them, it’s better to have one page with strong headings and several paragraphs.
  - Sliders were a great way to make a lot of content easier to digest, but clicking sliders to open them has become a problem, especially with mobile devices. Try using more headings, images, and bullets to break up your content rather than putting it in a slider.
- Don’t overload your navigation—the tabs and links that give users access to your pages. The typical human brain can only handle so much information at a time.
  - Follow the rule of seven—keep your navigation down to seven tabs. The same applies to the page links under each of those tabs.
FAQs

NOTE: Read the Webmaster’s Blog at http://blogs.mtu.edu/webmaster/ for instructions on CMS topics.

1. When was my page last published?
Outside the CMS, navigate to the live web page in question in a browser. Choose “View…Page Source” (Firefox) or “View…Source” (IE). Examine the metadata and look for a tag like this:

    <meta http-equiv="Last-Modified" content="2009-11-13T16:38:0500" />

The string "2009-11-13T16:38:0500" tells you that the file was last modified at 4:38 p.m. (16:38) on November 13, 2009 (2009-11-13).

In Firefox, you can see “Last-Modified” by typing cmd+i (Mac) or ctrl+i (PC).
Also, read http://blogs.mtu.edu/webmaster/2010/02/publishing-schedule/ for the publishing schedule.

2. How do I know if I have files checked out?
You can click Views > Checked Out By Me in the Content Explorer’s navigation pane or follow these steps for a complete search for files in various states (QuickEdit, Draft, Archive, etc.)

   1. Right Click on the site folder...select "Search in Folder"
   2. Select Advanced
   3. Select Customize
   4. In the top portion, select “Checked out user name”
   5. Click the "Select" button with the down arrow and Click OK
   6. Wait for the search screen to change
   7. Enter your userid in the checked out field
   8. Click OK

NOTE: When you open a file and don’t check it in when you’re finished, you block access to the file by others.

3. What do I need to know about naming a file?
Here are a few good tips:

   • Don’t include spaces or other punctuation in your file name. If necessary, use dashes in this manner: “my-new-file”.
   • Try to keep your file name short while still making sense.
   • Use lowercase.
• Try to avoid using years, version numbers, or other naming patterns that date a file. Maintenance is reduced and user experience is sustained when you can just overwrite the old file with the new one each year and keep the filename the same.


4. If I archive a file can I get it back?

Yes, an archived file can be transitioned to the Draft or Public states by people who are in the role of Web Admin or Quality Assurance.

5. Can I view my page before it’s published?

Yes. Right-click on the page you want to preview and select an option on the list based on your Content Type.

   Generic—Choose P – Generic
   Highlight—Choose S – Spotlight
   Image Editor—Choose the size you want to see. If it isn’t cropped and available in CMS, you’ll see a message that says “Image Size Not Defined.”

If your page preview does not appear:

1. Check to see if it is displayed in a new tab in your browser.
2. Make sure your browser pop-up blocker is disabled. (Windows Firefox: Go to Tools > Options > Content and uncheck “Block pop-up windows.” Mac Firefox: Go to Firefox > Preferences > Content and uncheck “Block pop-up windows.”)

6. What is an Impact Analysis in the CMS?

It is a report that shows you all the Content Items related to the one you’re reviewing. It is an essential tool when a Content Item is archived and for see who else on campus is using your content.

1. If a content item is archived, the entire site can be checked for other content items that use this item. An example of this is a form or file. When a form is archived, make sure that other pages referring to that form are updated.
2. Find the content item being archived in the content explorer.
3. Right click on the content item, and select “Impact Analysis”
4. In the “Impact Analysis” window, select “Active Assembly” for the relationship choice.
5. The “Ancestors” window will display the pages that use this item.
6. Expand the Ancestor files to see all of the items that link to that page.

7. Can I email a CMS link to others so they can preview it?

Yes. They will still need to access to the CMS to view a CMS URL. Just paste the URL in your email to the person who will review the page.
8. Can I rollback an item to a previous revision?

If you need to have an item rolled back to a previous version, or if edits were made that were not necessary, an old version can be revived. To do so, the item must be in a checked-in QuickEdit state. Once you have an item in the QuickEdit state, ensure that it is checked-in (right-click the item and select “Check-in”) and right-click the item to select “View More Information.” In the sub-menu select “Revisions”, a new window will open. The revisions are order by date, once you find the date/revision that is appropriate to be restored, select “Promote” from the left column. Ensure that you click “Update” on the new window and return the item to public.
A

Action Menu
A menu of functions that enable a user to take action on a Content Item or Folder. Action menus are accessed by right-clicking on a Content Item or Folder in the Content Explorer. Action menu examples include Preview, Workflow and Active Assembly.

Action Panel
The ability to refer to content using a URL link inside an email, a technical discussion or alternative forms of communication. The URL links to a web page that displays a Content Item plus the equivalent to the Action Menu in the Content Explorer.

Active Assembly Table Editor
A text-only interface that displays the available Slots for a Content Type, and enables users to add, remove, and reorder Content Items within the Slots.

Ancestor
Each dependent Content Item in a Relationship has an owner. The owner of the owner, and its owners, are ancestors of the dependent.

Audit Trail
A list of all Workflow actions for all revisions of a selected Content Item.

B

Breadcrumbs
A navigational technique displaying all visited pages leading from the home page to the currently viewed page. All pages are linked for easy backwards navigation. Breadcrumbs are typically placed near the top of a web page.

C

CMS
This is an acronym for content management system. It is a set of development features and applications used to create a framework for storing and communicating content for a specific destination, such as a website. It supports a cycle, or workflow, of creating content, evaluating and approving it, merging it with formatting, and publishing it to a destination. Multiple users can use the same content and reformat it for their web readers.

Community
A group of roles that require access to similar information, including Content Types, Workflows, Templates, Sites and user interface components. A role can be associated to more than one Community, and users belong to all Communities associated with their role.
Content Types
A form for displaying and editing a specific Content Type. Content Types list and display the contents of the System Title field and other fields of a Content Type. Content Type fields may be common to the system, shared by more than one Content Type, or local to that Content Type. A Content Type requires at least one local field.

Content Explorer
The Rhythmyx interface used by content contributors to create, modify and transition Content Items. The interface contains a Navigation Tree which contains Site Folders, Display Folders, Views and Searches. The Display Pane provides access to Content Items and Folders.

Content Item
A unit of content in text, image or file format that appears on a web page. Content Items consist of data and metadata.

Content Type
An aggregation of a Content Type, Templates, and related applications. Each Content Type includes metadata fields which provide useful information about that content. Every Content Type has its own backend table in the repository.

Cross Site Linking
The ability to reference and use Content Items that appear under one Site in another Site. Cross Site Linking is accomplished by placing a linked copy of the original Content Item in a different Site. Since the Content Items are linked, edits to one of the documents will also appear in the other. Cross Site Linking is only available when using Site Folder Publishing.

D

Dependent
The subordinate Content Item in a relationship. For example, in a Translation Relationship, the Translation Copy is a dependent of the original (owner) Content Item.

Descendant
Each owning Content Item in a Relationship has a dependent. The dependent of the dependent, and its dependents, are descendants of the owner.

Display Formats
A definition of the columns included in the Display Pane when selecting a View, Folder or Search node in the Navigation Pane. A Display Format can also define the categories used for grouping below the View or Search node in the Navigation Pane.
F

Folders
A node in the Content Explorer Navigation Tree for organizing Content Items and sub-Folders. When used under a Site node, Folders can define the structure of the published Site.

G

Global Template
The definition of common features for pages on a web Site or in a document. Templating enables the developer to create a master Template that can be used in conjunction with local Template items and thus have the advantage of reusability and consistency within the Site.

I

Impact Analysis
The ability to check relationships that exist on a Content Item, and thus determine any impact if the Content Item is modified. The Impact Analysis window displays the owners, dependents, ancestors and descendants of a Content Item.

Item Index
An automatic aggregation of Snippets resulting from a user selected query. These Snippets are placed into a Slot on another Template and updated each time the parent page is assembled. Common uses are lists of the ten most recent Press Releases or Events occurring in a particular month. Often Auto Indexes use additional data, such as a title, provided by the contributor when creating the Snippet.

K

Keyword
The fields used in the system that have specified values. Keywords simplify the development of Content Types by defining fields that accept a limited range of values, and storing those values in the repository. Using the Keyword Editor, users can define both the keywords and the values assigned to those keywords.

L

Landing Page
The index page for a specific section of a Site. When a user clicks on a navigation link, the page that the user is directed to is the landing page.
**M**

**Managed Navigation**

A feature that provides implementers the ability to create common navigation without needing complex Velocity or XSL, while creating navigational structure based on the Site's Folder structure. This typically includes top, bottom and left side navigation bars and breadcrumb trails. Managed Navigation is based on three navigation Content Types:

- **Navon** - Items used to create navigation menus including breadcrumbs, bottom, side and top navigation, and Site maps. Each Navon should be linked to a Content Item not used for Navigation.
- **NavTree** - Similar to a Navon. NavTree items only reside at the root of a Site. A NavTree initiates the propagation of Navons to every sub Folder in the Site Tree. The NavTree item is generally linked to the Site's Home Page Item.

Implementers and Webmasters can use the Managed Navigation elements to create new sections of the Site, move pages from one section to another, change the navigational label or image on a section, reorder sections, and remove sections from the navigation menu completely. Managed Navigation is only available when using Site Folder Publishing.

**N**

**Navon (NAVigation section)**

An item that describes the navigation for a single section or subsection of a Site. A Navon typically displays a system name or label, and a landing page. A Navon may also be associated with a NavImage.

**NavTree**

A Content Item which denotes the root of a Site and is responsible for propagating Navon Items in the Site Folders below the root. The NavTree establishes relationships between each of these Items. The result is a navigation hierarchy linking all levels of the Site together.

**Notification**

An email message that Rhythmyx automatically sends to a Role when a Content Item enters a determined State.

**O**

**Owner**

The original Content Item in a relationship. For example, in a Promotable Version Relationship, the original item is the owner and the promotable copy is the dependent.

**P**

**Page**

The final output of the Content Assembly process. A page is produced when a Template is applied to an item of content. The Template applies format and layout to that item and aggregates together all other required Snippets. As each Snippet is requested, the assembler processes the Template for that Snippet.
Each related Snippet is processed recursively until all required Snippets are generated, and assembled into the right parts of the page. The Content Assembler makes this final page available at any time through a URL. The Publisher uses this URL to extract the page from the system to save it out as a file.

**Properties**

The metadata associated with a Content Item or Folder. Rhythmyx provides a properties view for viewing a Content Item's properties, and a Folder Properties dialog for viewing or editing a Folder's properties.

**Quick Edit**

An editing option and a Workflow state that enables a user to easily correct a minor error on a public item. The item is transitioned to the Quick Edit state, where it can be edited. After the edit, the user can return the item to a public state without going through the complete Workflow process. Due to the power of this capability, it should only be granted to specific roles.

**Related Content**

A Content Item may include other Content Items in its assembled formats or Templates. For example, a Content Item may only hold text content, but one of its assembled Templates includes an image for illustrating the text. The image Content Item that is included in the Template is related content of the text Content Item.

**Relationship**

An association between two objects in Rhythmyx. Often these two objects are both Content Items, but they can also be Folders. One of the objects is the owner and the related object is the dependent. For example, in a Related Content Relationship, the original Content Item is the owner and the Content Item that is added to one of the owner’s Slot is the dependent. Frequently used relationships include Active Assembly and Promotable Version Relationships.

**Revision**

A modification to an existing Content Item after that Content Item has been published.

**Role**

A collection of Rhythmyx users with the same permissions and access. Roles are associated to both Communities and Workflow. A Community role grants members of the role access to the Community; a Workflow role grants members of the role rights to transition or view Content Items in the Workflow.

**Rhythmyx Server**

Installed as a service on Sun Solaris, Linux, Windows 2000 and 2003 environments, the Rhythmyx Server is the fundamental processing engine of the CMS system and is used to communicate with the back-end repository, Application Server, and Content Contributor clients.
S

Search
A query that returns Content Items that match selection criteria. Searches can be customized and saved, enabling content contributors to reuse selection criteria.

Shared Template
A Template that is used by more than one Content Type. Once associated with its original Content Type, it is associated to other Content Types by dragging and dropping it within the Workbench. The S – Callout Template in FastForward is a shared Template, and is associated with Brief, Calendar, Contact and other Content Types.

Site
The location where Rhythmyx content is published, such as a web site, file system, ftp location, or database. Additionally, Sites are a group of Folders which enable organization of Content Items in the Content Explorer.

Site Explorer
The interface that displays all of the Content Items that are linked together as a virtual representation of a Web site. Content and links can be rearranged in Site Explorer, and Content Items specific Slots can be created or edited.

Slot
A container to control the layout of aggregated Content Items. Each Slot defines a location on the page and the types of content that are allowed within that part of the page layout. When multiple Content Items are aggregated together, a Slot controls where those items appear in the final page.

Snippet
A partially assembled page element generated when certain Templates are applied to an item of content. Each Snippet may contain other aggregated Snippets, as well as formatted content.

State
A stage for a Content Item in a Workflow. In each State, content is available to users in specified Roles, who can apply Transitions to move the Content Item to another State in the Workflow.

T

TinyMCE
A JavaScript/HTML WYSIWYG (What You See Is What You Get) editor that allows content to be inputted and styled.

Transition
An action that a user applies to a Content Item while it is in a Workflow state. Each Workflow state has specific transitions applied to it.
WebDAV (World Wide Web Distributed Authoring and Versioning)
A set of extensions to the HTTP protocol which enables users to collaboratively edit and manage files on remote web servers. Using a WebDAV enabled application; users can contribute content to Rhythmyx without logging into the Content Explorer.

Workflow
A business process that defines a sequence of events. Each Content Type is assigned a Workflow. The Workflow defines and controls the sequence of events that occur to Items of that Type throughout its lifecycle.